Developing a Layout Template for Digital References and Studies

By Francis Adams

Part VI

After planning the subject and content of your Digital Philatelic Reference or Study (DPS), important questions remain. “What should the layout look like?” “How can I make all the pages look the same?” “How can I re-use elements to minimize the effort?” “Is there a way to automate some of the work?” These main questions can be addressed through use of a master layout template.

A well-designed template keeps our design consistent by maintaining a standardized format across all pages for the common elements within the study. This practice allows us to concentrate on our intent and creativity rather than the daunting task of adding every individual item manually and making sure the basic stuff works.

The following steps are meant to introduce concepts and methods. Additional bells and whistles are yours to develop in making your DPS and work unique. We’ll use basics from the pyramid structure outlined in Planning a Digital Reference and Study (TPC Fourth Quarter 2007) and some of the typeface, style, size and alignment information from Formatting a Digital Reference and Study (TPC First Quarter 2008) in designing our template.

Our Most Important Goal

Good layout and consistency function without notice.

Layout of a Content Page

It is important to visualize a page’s layout and be able to rearrange its components without being afraid you’re breaking something. An easy way to do this is to forget the computer for the moment and imagine we’re back in kindergarten.

Begin your layout development using common tools. A pencil, ruler, graph paper, and a few note cards will do nicely. Don’t be shy — break out that old crayon box with the blunt-end scissors.

Draw several squares or rectangles in various sizes and color them lightly in different colors. Make sure they’re not too small so they’re easily manipulated and cut them out like puzzle pieces. Let’s make a couple of small circles or ovals while we’re at it and color them as well (in different colors than the larger pieces). These pieces can be moved around and even overlapped. We’ll see how the pieces might fit together and how our layout might look and feel. It’s a very basic exercise with generally superior results as we are having fun and not worried about complex technology.

Next, let’s arrange the pieces to determine the size and placement of the header, content, and footer for our content page layout. Remember, simplicity is good, but innovation is better. I’d like to encourage you to design and go beyond my strict block layout example — it’s only a learning tool. As always, the choice is yours and block layouts are not bad things. Once the main pieces are in place, write the names Header, Content, Footer, etc. on them. (Fig. 1)

We’ll also use PowerPoint’s default page layout for the ‘title’ page as it will differ from the layout of our content pages. You may decide to make additional layouts depending on the need for subsections, or special content in your study.

Congratulations! You’ve just designed a basic layout for your study. Put the crayons, ruler and the scissors away and get a snack — you deserve it.

Ready, Set, Power On

Words in Advance

We’ll use Microsoft PowerPoint simply because many people have access to it. Instructions will be limited to the necessary steps to build a basic template.

Note: The following instructions were developed using a Macintosh version of PowerPoint. Menus in the Windows version may not be exactly the same, but the methods will be very similar.

Hardware / Software

Ensure your computer is operable, has an appropriate version of Microsoft PowerPoint software installed, and that the program runs. (Phase 1 is complete.)
TPC includes the officers, Editor Albert W. Starkweather, and Executive Committee.

The Council includes:

Philatelic Communicator are those of the authors, and not necessarily of Writers Unit #30, APS, its officers, editor, publisher, or agents. Letters and e-mails received by the editor may be printed unless labeled "Not for Publication." Every effort is taken to ensure accuracy, but validity is not guaranteed. Some product names and images may be trademarks or registered trademarks, and are used only for identification and explanation, without intent to infringe. All editorial matters must be handled by the editor.

Deadlines for receipt of copy by the editor:

First Quarter: January 15; Second Quarter: April 15;
Third Quarter: July 15; Fourth Quarter: October 15

The Philatelic Communicator four times a year. A subscription to TPC is included with dues paid by members of the Unit. TPC is printed and distributed by Wilcox Printing & Publishing, Inc., Madrid, Iowa. Content ©2008 Writers Unit #30; Design ©2008 Albert W. Starkweather / Design on Demand.

Manuscripts are solicited on subjects of interest to writers, editors, and publishers of all forms of philatelic literature. All submissions for publication, without exception, are subject to being edited. Electronic submissions are preferred. Opinions expressed in The Philatelic Communicator are those of the authors, and not necessarily of Writers Unit #30, APS, its officers, editor, publisher, or agents. Letters and e-mails received by the editor may be printed unless labeled "Not for Publication." Every effort is taken to ensure accuracy, but validity is not guaranteed. Some product names and images may be trademarks or registered trademarks, and are used only for identification and explanation, without intent to infringe. All editorial matters must be handled by the editor.

About the Editor

Albert W. Starkweather, Editor
5520 Gunn Hwy. #1406, Tampa, FL 33624-2847
phone: 813-962-7964; www.starkweatherdesign.com
email: astarkweather@wu30.org

Heather Sweeting, Associate Editor
14329 Victory St., Sterling, NY 13156-3172
315-947-9791; email: hsweetin@twcny.rr.com

Writing Unit #30, a nonprofit organization, publishes The Philatelic Communicator four times a year. A subscription to TPC is included with dues paid by members of the Unit. TPC is printed and distributed by Wilcox Printing & Publishing, Inc., Madrid, Iowa. Content ©2008 Writers Unit #30; Design ©2008 Albert W. Starkweather / Design on Demand.

Manuscripts are solicited on subjects of interest to writers, editors, and publishers of all forms of philatelic literature. All submissions for publication, without exception, are subject to being edited. Electronic submissions are preferred. Opinions expressed in The Philatelic Communicator are those of the authors, and not necessarily of Writers Unit #30, APS, its officers, editor, publisher, or agents. Letters and e-mails received by the editor may be printed unless labeled "Not for Publication." Every effort is taken to ensure accuracy, but validity is not guaranteed. Some product names and images may be trademarks or registered trademarks, and are used only for identification and explanation, without intent to infringe. All editorial matters must be handled by the editor.

Deadlines for receipt of copy by the editor:

First Quarter: January 15; Second Quarter: April 15;
Third Quarter: July 15; Fourth Quarter: October 15

The Philatelic Communicator

The answer, of course, was a newspaper. The overall effect of black

WU #30 members and advertiser reaction to the

increased cost for production or to Writers Unit #30 members.

The upgrade will help to fulfill three goals — (1) attracting new
WU #30 members and TPC advertisers, (2) giving the journal additional eye appeal by eliminating the gray factor, and (3) being able to run articles dealing with color use.

The ability to run color will eliminate the problems that Francis Adams has encountered explaining use of color in his excellent series on digital references and studies.

Readers can also expect to see articles relating to converting a publication to color, applying color to publication elements, image editing, and philatelic-related digital photography. WU #30 members are invited to submit articles relating to their experiences in converting their publications to color and how they use it.

The old riddle was: “What is black and white and red all over.”

The answer, of course, was a newspaper. The overall effect of black type and images on a white background was gray. In an ever increasing visually oriented world, even newspapers have been forced to redesign in color.

I can attest to the power of color. Circulation of the Federation of New York Philatelic Societies Stamp Insider has nearly doubled since it converted to color in May 2006. Positive reader and advertiser reaction to the Stamp Insider’s conversion to color have far exceeded my greatest expectations.

Breakfast Cover

Noted stamp designer Chris Calle again produced the limited edition cover for the Writers Unit #30 breakfast at StampShow 2008 in Hartford. It features a cachet of Mark Twain, who lived in Hartford and the show cancellation on the Albert Bierstadt stamp released at the show.
StampShow Breakfast; Board Meeting Reports

The Writers Unit #30 breakfast at StampShow 2008 in Hartford was another success, as more than 70 people attended. David E. Failor, USPS Executive Director for Stamp Services, provided an entertaining overview of the USPS stamp program.

Hall of Fame members — Thomas J. Alexander, Pandelis J. Drossos, Robert F. Dumaine, and Robin M. Startup — were inducted. StampShow literature awards were presented. Attendees received a commemorative event cover by stamp designer Chris Calle and specially cancelled stamps on the event program. Thanks to breakfast chairman Steven Rod, attendees also received a copy of J. W. Scott’s Metropolitan Philatelist from the 1890s. He also put together the largest group of door prizes in recent memory with more than 30 books, catalogues, and other prizes, valued at nearly $1,000.

The Board met after breakfast. Committee report highlights:

Awards: Robert Odenweller will provide draft of criteria and procedures for writing in non-philatelic publications by November 1.

Historian: Steven Rod is working with the president on a unit history; his first in a series of columns was published in TPC.

Literature Exhibitions: Jim Graue will provide a draft list of 2009 literature exhibitions to the editor by November 1 and ensure that a palmares for each event is provided to the editor.

Publicity: Ernest Fricks to provide a draft publicity plan for 2009 by November 1.

Recruiting: Lloyd de Vries will present a 2009 recruiting plan by November 1. Plan to place added emphasis on reaching more people, including a letter to all philatelic presidents and editors.

Special Events: Kenneth Trettin will present a 2009 round tables/training/presentations at the two annual shows plan by November 1.

Breakfast: Rod commended for outstanding job at StampShow.

Hall of Fame: 2009 nomination announcement to appear in the first quarter TPC. Peter Martin will investigate obtaining a permanent HOF plaque for placement in the American Philatelic Center.

Editor: Color to be added in 2009. Can always use more articles.

Bylaws: Katrina Everhardt is working with George Griffenhagen to finalize a draft for presentation to the board.

Web site: Andrew McFarlane needs input for updates.

New Business included discussions about the following:

New StampShow Medals: Will be reviewing ways to reduce the current $25 each cost without diminishing quality.

Secretary-Treasurer: The Board approved a special plaque for the secretary-treasurer for his 25 years of exceptional service.

2009 Election: Lloyd de Vries was appointed to fill the VP vacancy left by the death of Barth Healey. 2009 will be an election year.

New Writing Awards: The awards chair to develop criteria that can be finalized by the February meeting.
Backup! Backup! Backup!
All computer users should back up their data on a daily basis, including e-mails. I know a journal editor and a columnist whose computers suffered total meltdowns, forcing them to spend countless hours of resurrecting data. I also had two drive failures this year and was back at work within minutes. Why? I have a pair of mirrored external hard drives for data only and an automatic backup program. I also have an uninterruptible power supply that ensures no data is lost when — not if in Florida — the power goes out.
— Albert W. Starkweather

Casting a SPELL
The late Ernst Cohn talked me into joining SPELL (the Society for the Preservation of English Language and Literature), a non-profit organization. It publishes an eight-page bimonthly newsletter with interesting feature articles on correct word usage, common grammatical errors, informative letters to the editor, mentions of new books such as dictionaries and thesauruses, and a Grammar-Gram similar to a crossword puzzle.

One of the more humorous features is the two-page Murderers’ Row center spread of items sent in by members when they find egregious errors of spelling or grammar in advertisements, newspapers, magazines, and other media. Occasionally there are wonderful, often tongue-in-cheek, articles by SPELL vice president and well known author Richard Lederer.

Details about the organization, including membership, can be obtained from SPELL, P. O. Box 321, Braselton GA 30517; WWW.SPELLORG.COM; OR SPELLGANG@JUNO.COM.
— Alan Warren

New Zealand Literature Exhibition
The 11th New Zealand National Philatelic Literature Exhibition will be conducted by the Manawatu Philatelic Society on June 27, 2009 in Palmerston North. There are no entry fees or forms. Submission deadline is April 30, 2009. For more information contact Tony Thackery, secretary, at t.c.thackery@xtra.co.nz.

Dyslexia Never Has Been This Much Fun
People calling a federal phone number to order duck stamps late this summer were greeted instead by a phone-sex line due to a typo. The carrier card for the stamp transposed two numbers. Instead of listing 1-800-782-6724, it listed 1-800-872-6724.

The first number spells 1-800-STAMP24, while the second spells out 1-800-TRAMP24. People calling that second number were encouraged by a husky female voice to “talk only to the girls that turn you on” — for $2 a minute. The Fish and Wildlife Service said it would be too expensive to reprint the cards at approximately $300,000. “That’s a lot of money we can be using for wildlife conservation,” said agency spokeswoman Rachel Levin.

Grammar Horror Alert!
The British supermarket chain Tesco used to have signs at its express checkout saying 10 items or less. Then grammarians complained, pointing out that the signs should proclaim 10 items or fewer. Tesco thought “or fewer” sounded awkward, and opted for new signs that read Up to 10 items.

But it is what happened next that makes this incident notable. The British Broadcasting Corporation recounted the Tesco affair on its Web site (www.bbc.co.uk), and readers from around the world wrote to draw attention to grammar rules they see being flouted. Here are some of the best, in the readers’ words.

• … people suddenly seem to confuse have and of, as in: “I could of learnt how to write properly.”
• The proper use of its and it’s seems to confound many people, with its being a possessive and it’s being a contraction of it is.
• If you do something to change a situation, then you effect a change. If your circumstances are changed by an action, then the change has caused an effect. You cannot affect a change in something, nor can you be effected by one.
• Many … incorrectly use I instead of me. For instance, they say, “She said some very kind things about George and I.” An easy way to remember which to use is: If you would say him or her on its own, use me; if you would say he or she on its own, use I.
• Incorrect use of reflexives make my blood boil. People will say yourself and myself when they just mean you or me. Those who use it correctly can give themselves a pat on the back.
• As a teacher, I’m beginning to despair when it comes to they’re, there, and their.
• I cringe when I hear reporters say amount of people when it should be number of people.
• The editor’s pet peeves include:
• The media’s use of troops instead of soldiers in reporting deaths. A troop is a unit of soldiers that forms a subdivision of a cavalry or armored cavalry squadron.
• Misuse of over, which describes a spatial relationship: “The flag flew over the capitol.” More than expresses a numerical relationship: “More than a dozen philatelists met at …”
• Insure and ensure — The former meaning to cover property with insurance, while the latter means to make sure or certain. “I would like to ensure that everyone is insured.”
What are your pet grammar peeves? What really makes your blood boil? Send us a letter or e-mail.

Expert Help for Writers and Editors
Charles J. Peterson, Writers Unit #30 past president, offers free critiques of periodicals and books / manuscripts. Submit the four most recent issues, including postage equivalent to four times the first class mailing fee. Any unused amount will be returned. Critiques can be expected in about 30 days. Inquire before sending books and manuscripts, providing a brief description. Return time will vary, depending on length and other commitments. Include a SASE. Send to Peterson at P. O. Box 5559, Laurel, MD 20226. His phone is 301-776-9822; e-mail cjpet7777@aol.com.
Laying the (File System) Foundation

Begin by making a new folder on your computer to hold all your study files and graphics. This new folder can be named anything you wish and may be stored anywhere you choose on your computer's hard drive or even on external media. The typical default location is usually the documents folder.

1. Click on the New Folder icon in the tool bar.
2. Name this folder My Famous Study (or a name of your choice).
3. Open this new folder and make another new folder inside it named Images. All your graphic images will be stored here.

Adding subfolders within My Famous Study to organize study materials guarantees you’ll know where things are when you need them. Organizational options include arranging files by file format (i.e., pdf or doc) or document type (i.e., interviews or references). Ordering them by state is also an option — i.e., complete or finished. The arrangement is up to you, but using a system of some sort will make life easier later.

Reviewing PowerPoint’s Interface

Let’s crank up the PowerPoint software.

1. Locate and open the PowerPoint application on your computer.
   - Windows Start ▶ Programs ▶ MS Office ▶ PowerPoint.
   - Mac Mac HD ▶ Applications ▶ MS Office ▶ PowerPoint.
2. The PowerPoint application opens.
3. The Project Gallery screen appears.
4. Select PowerPoint Presentation.
5. Click Open ▶ Blank Documents.
6. A new document window appears and the screen displays a blank slide. The title slide layout is displayed by default with text blocks for the title and sub-title included. (Fig. 2)

A series of small icons appears in the lower left of the main window. These icons allow the window display mode to cycle between Normal, Outline, Slide, Slide Sorter, and Slide Show views depending on which is chosen.

A Drawing toolbar may also be located at the bottom of the screen. If the toolbar is not showing, choose View ▶ Toolbars ▶ Drawing.

Our First Study

Let’s start with a basic PowerPoint file which we can modify using the screen we just opened.

1. Click on the Title text and enter the name of your study. (Fig. 4)
2. Click on the Subtitle text and enter the subtitle of your study.

   Fig. 2 Project Gallery Window

This is the Normal View for PowerPoint documents and there are three panes visible in this view:

1. The Outline pane, left, which shows the thumbnail view of the slides in your study,
2. The Slide pane, right, the area for adding data (main area),
3. The Notes pane, bottom is for such information as file location,

   etc. Click in the window to add notes

   The ribbon areas across the top and to the left hold menu selections and tool bars. (Fig. 3)

   Fig. 3 Normal View with Three Panes

   A series of small icons appears in the lower left of the main window. These icons allow the window display mode to cycle between Normal, Outline, Slide, Slide Sorter, and Slide Show views depending on which is chosen.

   A Drawing toolbar may also be located at the bottom of the screen. If the toolbar is not showing, choose View ▶ Toolbars ▶ Drawing.

   Fig. 4 Title Page Template

   Click to add title

   Click to add subtitle

3. Reposition or resize the text boxes as desired using the box handles, which are small squares in the corners and middle of the boxes.
4. Select the Title text and reformat it by setting the typeface, style, size, and alignment.
5. Repeat steps 3–4 for the Subtitle of the study.
6. If a Copyright / Author / Date or other boxes are desired:
   Insert ▶ Text ▶ Text Box
7. Repeat steps 3–4 for these boxes. (Fig. 5)
Template — Continued from Page 5

Save this file with a shortened version of the Title of your study. That way it will be obvious what it is, but it won't be confused with other files. Ensure you've saved it into the folder My Famous Study.
8. From the main toolbar, select File ▶ Save As.
9. Name the file by typing in the File Name box.
10. Select the location to save the file to in the Save In box. (This will be your new subdirectory folder in My Famous Study.)
11. Select the file type in the Save as Type box ▶ PowerPoint (.ppt) format. (It may already be selected.)
12. Click Save.

Note: Multiple column layouts are also an option. We are using the most basic layout to keep these instructions reasonably short.

Color Schemes

In this exercise, we'll use a standard color scheme included with PowerPoint. These schemes match colors and shades for text, backgrounds, etc. so the overall look of the study is pleasant.

To coordinate our color scheme:
1. From the main menu, choose Format ▶ Slide Color Scheme. (Fig. 6)
2. Choose the desired option — White background, black text and blue highlights in this case.
3. Click Custom to see the itemized color settings.
4. Click Apply to All.
5. Select File ▶ Save from the main menu.

Note: Other options for slide design also appear under this menu choice. We're only using the most basic of choices here.

Building a Slide Master

A Slide Master is the heart of our template and allows us to apply common, static items and styles to the entire study. We can set up text block positions, typefaces, sizes, styles and colors.
1. To insert a new slide to develop the slide master choose Insert ▶ New Slide.
2. To display the slide master choose View ▶ Master ▶ Slide Master. (Fig. 7)
3. The Slide Master appears. (Fig. 8)
4. Reposition and resize the Master Title using the box handles.
5. Click on the Master Text box.
6. Reword the text to Click to edit content text.
7. Highlight the text and reformat the text typeface, style, size, alignment, and paragraph spacing.
8. Highlight the text and turn off the Bullets and Numbering.
9. Reposition and resize the Master Text using the box handles.
10. Delete the Date/Time box in the lower left corner.
11. Click on the Footer box.
12. Reposition and resize the Footer box using the box handles.
13. Delete the text <footer>.
14. Enter the word Home followed by a double space and a pipe symbol (|) followed by another space.
15. Enter the word 'Introduction' with a double space and a 'pipe' symbol (|) followed by another space.
16. Enter the Section' titles of the study followed by pipes and double spaces between words.
17. Enter the word References.
18. Select all of this text and resize it accordingly to fit the box.

**Note:** We’ll return later and incorporate navigation hyperlinks.
19. Click on the (page) # box.
20. Highlight the # and reformat the typeface, style, size, and alignment as desired.
21. Reposition and resize the # box as desired using the box handles.
22. Select File ▶ Save from the main menu.

**Using the Template**

We’ll add a new slide for each Section of the study.
1. Choose Insert ▶ New Slide. The default layout appears, with our layout boxes in their correct positions.
2. Enter the desired text (subtitle, placeholder text, etc.) in the appropriate boxes. *(Fig. 10)*

**One Size Does Not Fit All**

In some instances, this basic template may not be exactly what’s required for all of your content and it’s not necessarily meant to be. The template is the lowest common denominator of your design and it is there to perform the grunt work so you don’t have to. Some modifications are to be expected. The template should be a helpful and flexible guide, not a rigid taskmaster.

The format of individual pages can be modified for specific content by re-positioning, deleting or adding boxes on a specific page to suit your needs.

1. Insert ▶ Text ▶ Text Box as desired.
2. Reposition and resize the new text box using the box handles.

**Conclusion**

With our layout and template defined, our master plan is almost complete. Addition of a page and section navigation system will provide the ability for users to move from one section to any other section without going through every page sequentially to get to the desired destination. The next article will review how main section navigation can be incorporated into our document along with specific page movement. We’ll also embed links to draw on reference documents.
As mentioned previously, authors’ style guides are used by editors to assist and encourage others. The seed for the idea was planted by Kenneth Trettin: “Style Guide Smorgasbord,” The Philatelic Communicator, third quarter 2003, page 5.

Background

All writers must develop their own writing style. Otherwise the written word would be very boring, and it behooves all editors to bear this in mind when wielding their editorial pen. However, authors generally write for more than a single publication and cannot be expected to know every aspect of each publication’s style. Accordingly, it is the editor’s duty to make such changes to authors’ works that enables them to merge seamlessly into their publication, following the same rules and adhering to the same criteria for language usage. Since this is a fairly monotonous and boring part of their activities, many editors have developed style guides for authors to encourage newcomers to do most of the donkey work prior to the editor receiving the copy for publication.

Author guides are not the same as house style guides or manuals and standards manuals that contain details of typefaces and sizes, paper size and weight, cover binding details, etc. to ensure a publisher’s output retains the same feel and appearance of its publications over many years and often through many editors and printers. These are not relevant here and often are not available to the public. Accordingly, they are not listed in this bibliography, unless such details have been incorporated into the guides listed.

Strictly speaking, author style guides add nothing to the process of creating the written work. However, one does not have to write many thousands of words before the uncertainties begin to creep in: “What is the accepted way for this to be written?” or “How shall I best deal with that?”, and so on. This is where these guides help.

Introduction

As mentioned previously, authors’ style guides are used by editors to acquaint authors with the general rules they would like them to follow in preparing their manuscripts. This usually includes such basic issues as subject matter relevant to the magazine’s audience; spelling, figures, photographs, tables, and references; and, finally, how the editors would like the manuscript presented to them. In other words, all of the information required by writers in order to minimize the editor’s time and effort in preparing their work for publication and to avoid the need to completely resetting the material.

For most specialized publications this will require just a few pages and up to a dozen or more for complex publications. However, major publishing houses that attempt to create guidelines for all eventualities and across all subject areas can see their documents grow to major proportions. The most notable of these is the Chicago Manual of Style, which has grown to nearly 1,000 pages and constitutes a virtual encyclopedia for writers.

Owing to the relative paucity of philatelic authors’ style guides, I have collected all that I have come across, regardless of where they were published. In particular, there is a growing trend towards making these available on organizations’ Web sites. This has the dual advantages that authors can download a copy as required, saving the publisher the cost of having them printed and distributed, and that online documents can be updated easily so that the latest version is always available.

As well as philatelic style guides, I have also accumulated non-philatelic style guides and other books specifically intended to aid writers and publishers in all matters relating to the conversion of words into print. For convenience, I have used the term writers handbooks to cover these publications. Like their philatelic counterparts, they generally cover spelling, including capitalization and abbreviations; punctuation, including quotation marks; figures and numerals; and foreign languages. They also have a great deal of other useful information.

Since these are non-philatelic, I have restricted the listings to the few volumes that I have found useful over the years. Bear in mind that those listed are owned by me and may not be the current edition. Two exceptions are The Chicago Manual of Style and The Associated Press Stylebook, both of which I have purchased recently on the basis of Trettin’s recommendations in his writings. The writers handbooks are listed in a separate section at the beginning of the bibliography.

The Bibliography

Note: Comments and data enclosed in square brackets are mine.

Handbooks


**Style Guides**  
*Style Guide for First Day Cover Cachet Catalogues, [ca. 1997].  
Tucson, AZ: American First Day Cover Society, 15 pp.*


*Forand, Michel, March 1994. “Help! Authors submitting articles for the journal are requested to note the following guidelines.” United Kingdom: British Caribbean Philatelic Study Group UK: British Caribbean Philatelic Journal, Volume 34, Issue 1, p. 28. (See Herendeen below)*

**GSM Style (Gibbons Stamp Monthly), [Received in 1992].  
Ringwood, UK: Stanley Gibbons Ltd., 3 pp.**


**Scott Stamp Monthly Writers Guidelines, [Received in October 1993]. Sidney, OH: Scott Publishing Company (Amos Press), 12 pp. Editor’s note: Apparently out of print. (See “Linn’s Writers’ Guidelines” above).**


**About the Author**  
Brian J. Birch, trained as a metallurgist, is responsible for health and safety for a large UK-based multinational company in the metal processing field. He began to collect stamps at the age of 8 when his father introduced his elder brother to the hobby. By the mid 1980s, he had given up stamps and collected only philatelic literature, specializing in philatelic bibliography or the literature about literature. Anyone interested in his works, can find more on the Fédération Internationale de Philatélie (FIP) Literature Commission Web site at HTTP://HPS.GR/FIPLITERATURE. 

---

**Addressing Writers Breakfast**  
Steven J. Rod addresses the Writers Unit #30 at APS StampShow 2008 in Hartford on August 17. He provided door prizes and other goodies for attendees.
Books & Catalogues

CD Adds Value To Catalogue

**Historical Catalog of U.S. Postal Card Essay and Proofs**, Bill Falberg and Dan Undersander, editors. 384 pages with CD, 8½ × 11 inches, case bound. ©2008 United Postal Stationery. $59 retail, $47 members from UPSS Publications, P. O. Box 3982, Chester, VA 23831; www.upss.org.

The United Postal Stationery Society (UPSS) is gaining the reputation of publishing quality books in the highly specialized area of postal stationery and postal cards. This trend continues with the publication of its most recent effort that was released in August at APS StampShow 2008 in Hartford.

This compilation is a revision of a series of articles appearing in the *Essay Proof Journal* written by Clarence W. Brazer and George C. Slawson. Brazer intended on combining these articles along with new research into a catalogue, but died and Slawson never completed the work. Falberg took the original manuscript and added or deleted material that he believed was appropriate for the new catalogue. He admits that being the editor gave him discretion as to what the content would be. The new material, along with updated historical information, make this work compatible with the *U.S. Postal Card Catalog*, also published by the UPSS. With both catalogues in hand, a collector now has up to date and comprehensive information on U. S. postal cards.

Falberg kept the original classification system with only minor changes that are annotated in an appendix. The catalogue number is appended to a prefix to designate types of proof and other cards in a family. These are presented in table format in addition to the text and illustrations. The table also gives a short description and a catalogue value. Besides Scott numbers, the cards are also cross referenced to UPSS numbers in the new catalogue.

The illustrations are in black and white and generally of good quality. However, what makes this volume worth its price is the accompanying CD which offsets any disappointment when it comes to a lack of color. The CD contains a copy of the catalogue in Adobe pdf format with the images in color. As an added bonus the CD also contains a database with not only the 364 illustrations contained in the book, but also an additional 653 images that did not make the book.

The editors intend to use the CD as a library for future postal card essay proof images and to expand the database to include envelope essay and proof images. It can also be used for future updates for the book, although at this time it cannot be purchased separately.

— Alfred Carroccia

**Australian Air Catalogue Updated**


Well-known Melbourne dealer Charles Leski has taken over publishing the famous *Australian Air Mail Catalogue*, releasing the first edition in six years. It lists all airmails from Australia and Papua New Guinea.

The first edition was published in 1937. Nelson Eustis died in 2003 and this work was carried on by Tom Frommer, who has won large golds for his Australian airmail collection at internationals in 1996, 1998, and London 2000.

The publisher states:

“You will find it a dramatically enlarged and improved book. Firstly, it is in large A4 format. This has enabled us to include many more illustrations. There are many new entries, with particular emphasis on intermediates which have previously been lumped together. Many errors and omissions in the older text have been found and corrected and, of course, the valuations have been updated. This has involved collating and studying thousands of prices from major auctions like Leski’s, Harmers, Bonham’s, Cherry-stone, Gibbons, Prestige and others, as well as dealer’s lists and internet sales.”

The catalogue is laid out as follows: a list of Australian airlines, Australian first and special flight covers listed chronologically, rocket mails, pigeon posts, balloon posts, Papua New Guinea and special flight covers, crash covers. The appendices include Ross Smith covers, Australian pilots and important personalities index, Papua New Guinea pilots index, Australia airline index, Papua New Guinea airline index, Australian air mail postage rates, and an Australia air route map.

The new catalogue is very well done, and the illustrations are very good. I highly recommend it for anyone interested in Australian aerophilately.

— Ken Sanford
Handbook Expands on Catalogues

South African Airmails by Nicholas Arrow. 203 pages, perfect bound cover, A4 (8¼ × 11½ inches), color illustrations. ©2008 published by author, Musbury, United Kingdom. £30 (approximately $58) plus £10 ($19) airmail postage worldwide.

There have been three definitive catalogues of South African Airmails published since 1936. The first was The Airposts of South Africa by L. A. Windham, the second was South African Airmails by Capt. Milton F. Stern, published in the late 1960s, and the third Par Avion in Southern Africa by John T. Burrell, published in 1986. Each of the second and third catalogs expanded on the earlier ones.

This latest handbook, although it is not really a catalogue as it does not include pricing of covers, expands considerably on all three earlier catalogues. The first chapter covers pioneer and other special flights to August 31, 1939. It is written in narrative style. The volume includes a chronological listing of the flights and assigns a rarity factor of covers from each flight.

The second chapter covers internal scheduled flights through August 1939 and is in the same format, starting with the narrative, followed by a chronological listing of the flights. However, the rarity factor of covers is not shown in this and most of the subsequent chapters. The third chapter covers external scheduled flights to August 1939 in the same format.

The fourth chapter covers the war years and includes the Horse-shoe Route — mail between South Africa and the U.S., crash mail, air letters, aerograms and airgraphs, and a chronological listing of mails flown from September 1, 1939 to September 30, 1945.

The fifth chapter covers the post-war era through May 31, 1961, and describes the first flights of various airlines that have served South Africa, such as BOAC, KLM, Pan Am, Air France, Swiss-air, Sabena, and Qantas. This is also followed by a chronological listing of the flights between October 1, 1945 and May 31, 1961, where again the rarity factor of covers is resumed.

Chapter six covers the period June 1, 1961 through 1974, then 1975 to 1981, where the rarity factor again is dropped. Finally the period 1982 to February 7, 1994 is covered in both the narrative and a chronological listing.

There are a number of appendices which cover:
• Dates of intermediate or government experimental service flights;
• Note as to Rand Airport, which served Johannesburg
• A list of well known and prominent people to which many first and special flight covers are addressed
• Balloon and Helicopter, etc. flights
• Antarctic helicopter flights

Throughout the chapters, some covers are shown in color, but the illustrations are not as numerous as in Par Avion in Southern Africa, which this reviewer would have liked.

Also, there is no bibliography, which would have been useful.

The rarity factor should have been used throughout the listings as well.

Overall, the handbook is very well done and it is a valuable addition to the literature on South Africa Airmails.

— Ken Sanford

Translation Opens Study Area

The Return Post of the Danish Postal Service by Kurt Hansen and John R. Sabin. 96 pages, 5½ × 8 ½ inches, perfect bound, card covers. ©2007, JRS Publishing. $35 postpaid to U.S. addresses, $45 elsewhere from John R. Sabin, 415 NW 23rd St., Gainesville FL 32607-2618.

This book is essentially the translation from Danish to English of five articles by Kurt Hansen. John Sabin translated the articles and added some comments and end notes, making this subject matter more widely available to collectors. The articles originally appeared in Nordisk Filatelistisk Tidskrift, published by the Copenhagen Philatelic Club in 2004–2005. Hansen studied the handling of mail returned to the sender by the Danish postal service. Since he found little information in the literature, he compiled this record of the return labels or vignettes, the return resealing labels, and special return envelopes used by Denmark Post.

The first resealing label was issued in 1878 and was to be used only on returned domestic mail. The 1890 issue had four printings and thus more errors and varieties. Proofs also exist and the authors illustrate them. The labels were printed in sheets of eight and the varieties can be identified by position. Each printing is also identified by perforations and color shade.

Similar detailed treatment is offered for the redesigned labels that issued in 1915, 1930, 1934, 1935, and 1964. Further designs were released in the latter part of the 20th century, but there is insufficient information to date them accurately. An international resealing label was also used to return mail from the dead letter office to the sender abroad. Again, the period of use is uncertain.

Readers will see a number of covers in fine color showing use of these resealing labels. Also illustrated are several examples of special return envelopes in which the original letter was enclosed and addressed to the sender, often without additional postage required.

The final chapters describe various labels with specific instructions such as Unknown, Not Collected, Forbidden, Deceased, and Insufficient Address used for the return of international mail. The authors describe the printing of such labels in sheets and strips.

An appendix illustrates multiples of the domestic labels in blocks and strips. Some attempts at cataloguing were done by AFA and Facit, but the most complete listing is that of Scandinavian dealer Jay Smith. A table relates the three numbering systems to one another. The book ends with a glossary and reference notes.

Postal historians of Danish philately will gain a better understanding of the special treatment of mail described in this book. The color illustrations are excellent.

— Alan Warren
New Michel Catalogues

Michel catalogs are published in Germany in 152 x 203mm (6 x 8 inches) perfect bound format with mostly color illustrations in the European series and black and white illustrations in the overseas series. All text is in German, but the clear illustrations and format make them easy for anyone to use. Values for mint, used, on cover and FDC items are provided in euros. They may be ordered through the Michel Website — www.michel.de. For North American retail prices, contact the U.S. distributors, Lighthouse Publications, 274 Washington Ave., Hackensack, NJ 07601; www.lighthouse.us or Lindner Publications, P. O. Box 5056, Syracuse, NY 13220; www.lindner-usa.com.

Michel 2008 Austria Specialized Catalogue. 576 pages. The publisher’s list price is 46 euros.

This catalogue has become an indispensable reference for Austrian philatelists. The editors have continued to add to each succeeding volume, and this edition adds 84 pages of Austrian postal stationery for the first-time inclusion. Postal stationery is an important addition and features postal cards; pneumatic mail postal cards; postal savings cards; tax, telegram and telephone items; lettercards; reply cards; aerogrammes; special events cards, and stationery. Most of the illustrations in this section are black and white.

The catalogue is comprehensive and includes: regular issues through the January 18 WIPA stamp. The entire range of Austrian issues from 1850 forward is covered, including Austria-Hungary; Austria as part of the German Reich; Austrian Republic; Lombardy and Venicia; Austrian offices in Crete, the Levant and China; Bosnia and Herzegovina; ship mail; and field post offices. The vast majority of the nearly 5,500 illustrations are in full color.

Also listed are more than 100 new issues and special items, including the non-issued 2005 Dalai Lama stamp. Other additions are the newly identified varieties of the 1934 Dollfuss stamp, improved stamp booklet illustrations and the inclusion of circular number postmarks for the registered mail listings.

Based upon the listed values, the Austrian market is stable, with increases noted in specialized areas like stamp varieties; miniature sheets and small-format sheets issued since 1990; and postal history. Values for Europa (CEPT) stamps are trending downward, in some cases significantly so.

Michel 2008 Switzerland–Liechtenstein Specialized Catalogue. 576 pages. List price is 46 euros.

This catalogue has been upgraded to include 71 pages of postal stationery, with mostly black and white illustrations. Covering both countries. The comprehensive catalogue has more than 4,200 color illustrations and includes Swiss issues through November 20, 2007, and Liechtenstein issues through November 19, 2007.

The new postal stationery section includes postal cards, official and semi-official postal cards, special event cards, lettercards, air letters, and stationery. In addition to the stationery listings, highlights include: Swiss Canton issues, vending machine stamps and tickets, booklets, coils, official stamps, postage due stamps, telegraph stamps, air mail issues, locals, military mail, international organizations and Campione, as well as Liechtenstein vending machine stamps, official stamps, postage due stamps, and field post offices.

Noted were numerous value increases, particularly for Swiss airmail and official stamps, League of Nations issues, International Labor Organization issues, especially on cover, and Pro-Juventute stamps. Europa issues had slightly lower values. In general, the issues of the Principality of Liechtenstein have remained stable.

Michel 2008 Central Europe Catalogue (Europe Volume 1). 1,216 pages. List price is 48 euros.

The Michel Europe catalogues are the standard reference used by European philatelists. The detailed listings and easy to use format make it the popular choice for collectors seeking the most up-to-date values. Volume 1 covers Central Europe, including Austria, Czechoslovakia, Czech Republic, Hungary, Ljubljana (West Hungary), Liechtenstein, Slovakia, Switzerland and UN Geneva and UN Vienna. Issues up to the end of January 2008 are included. There are nearly 14,000 color images and more than 64,000 revised values.

Included in the listings is the unissued 2005 Austrian stamp to mark the 70th birthday of the Dalai Lama. It is a modern Austrian rarity and is valued at 1,000 euros. This area of Europe has seen an upward spiral in values, with many increases of 100 per cent or more. Examples include Austrian postal history and FDCs, numerous 1939–1945 issues from Slovakia and some Swiss issues.

Michel 2008-2009 Deutschland (Germany) Katalog. 1,104 pages. List price is 36 euros.

Michel’s standard Germany catalogue, akin to the U.S. lists in the Scott Catalogue Volume 1, is reasonably priced and organized by German collecting areas with chronological listings. Special stamps, such as officials or postage dues, are found at the end of each collecting area. A comprehensive index listing overprints and stamp inscriptions and survey lists of definitive issues is provided.

The Deutschland Katalog contains classic and modern German stamps though May 12. The catalog is divided into collecting areas such as: Old Germany, the North German Confederation, German Empire, foreign post offices, colonies and ship post abroad, occupation issues of the First and Second World War, plebiscite areas, Belgian military post in the Rhineland, Gdansk, Memel, Bohemia and Moravia, General Government, Sudetenland, field post stamps, local issues, Allied Occupation (joint issues, Berlin and Brandenburg, Soviet Occupation Zone, French Occupation Zone, American and British Occupation Zone), German Democratic Republic, Berlin (West), Saarland, Federal Republic of Germany, and Saarland as a federal state of the FRG.

Highlights in this edition include detailed information about definitives, commemorative stamps, variable-rate stamps, booklets, official stamps, postage due stamps, registration stamps, airmail stamps and more; survey lists of miniature sheets and definitive series; Lists of year sets with values based on dealer offers; A comprehensive section regarding expertization; a list of contact addresses for study groups; An updated keyword index in the appendix; More than 9,600 color images and nearly 59,000 values.

Noteworthy is the inclusion of a CD that is mounted in the catalog: MICHEL-Rundschau 2007, MICHELsoft easy and ABC search lexicon for FRG, Berlin and GDR.

This volume features a complete revision of the 1914–1918 German occupation issues. Many value increases were noted, especially for Upper Silesia, Gdansk postage due stamps, Port Gdansk, Bohemia and Moravia, General Government, and World War II occupation issues. There were some lower values, such as for the CEPT issues. The average collector will find this catalog more than adequate; specialists will prefer the Michel Germany Specialized Catalogue.

— Peter Martin
Paying Attention

Ralph Weil, editor of The China Clipper, the journal of the China Stamp Society, changed the format of the journal from one column (used for 72 years) to two columns. He read the review in The Philatelic Communicator and heeded the suggestion to switch to two columns.

Briefly Noted

The Precancel Forum is published monthly by the Precancel Stamp Society, Inc. Editor: Larry Patterson; www.precancels.com.

Precancel collecting is just as popular today as it was 50 years ago. If you thought there are no more varieties of bureaus and locals to be found, think again. The PSS employs an army of reporters to classify and count town and types as noted in the The PSS Town & Type Catalog of the U.S. & Territories. A good portion of this journal is devoted to publishing counts and reporting new finds, several of which are enthusiastically described and illustrated, in color. This method is a unique way to involve the membership in a meaningful and enlightening philatelic task beneficial not only to the PSS, but also the hobby as well.

There is an even mix of specialized and general articles geared toward the novice collector. Dilmond Postlewait is to be commended for authoring an excellent and straightforward primer on the basics of precancel collecting. Another short piece walks the reader through The PSS Town & Type Catalog and its unique classification system. Rounding out each issue is detailed news from different club chapters and many individual adlets from members on everything precancel. This is an excellent publication.

The Old World Archaeologist is published quarterly by the Old World Archaeological Study Unit. Editor: Caroline Scannell. 14 pages, 8½ × 11 inches, stapled; www.owascu.org.

The appearance of this important journal being stapled would lead the reader to believe it is a newsletter with no substantive information. However, the colorful masthead and a lead article telling the story of Hadrian’s Wall complete with illustrations of stamps in color jump out to draw the reader into this exciting topical area. This journal packs a treasure of both philatelic and non-philatelic information from the world of archaeology.

The editor and authors do a fine job of keeping a balance between philatelic and scientific information. Illustrations include stamps, covers and artifacts all in color. The illustrations are scanned clearly and easy to see details. Each issue also contains a comprehensive survey of recent issues related to archaeology. (See the next page for a review of its Web site.)


A glance at the table of contents of a recent issue of this journal was enough to draw my attention. An article titled “The O. J. Simpson of Czech Philately” is enough to turn heads! It is an interesting, but disturbing, story of two Czech collectors accused of selling forged Czech material. One of the accused even had the audacity to testify at his trial that he was not aware any of his material was forged. The court believed him and he was acquitted of all charges.

This journal covers all the different areas of Czech philately from its birth to its present status as Slovakia and the Czech Republic. Articles include a serialization explaining the myriad of varieties of arch types of the fifth design 25h Hradcany issue. An exhaustive survey it outlines all the plate varieties and painstakingly describes each variety in minute detail. It is lavishly illustrated. However, the illustrations are poor and details difficult to discern. It is a problem throughout the issues; even photographs are poorly reproduced. Other articles were reprints from other publications.

— Alfred Carroccia
Exploring Archaeology Online

The purpose of the Old World Archaeological Study Unit, according to its Web site, www.owasu.org, is to “collect and study postage stamps related to archaeology (and cultural anthropology for spice) from the stone age to the beginnings of recorded history.” The Web site is seeking a volunteer Webmaster.

The site’s pastel yellow backdrop is accented in blues and reds. Black sans serif text is extremely readable. Top-of-page tabs make navigation easy. The new digs tab shows the latest additions, many of which link to on- and offline articles and bibliographic information. There is also a section for members, novices, library, and a freebies section. The gallery is the best section, having links to many stamps and postal history examples split into study areas — prehistoric, Roman, Egyptian, old world, Pacific, African, and Asian cultures, museums, and famous anthropologists, scientists, and archaeologists.

The link, www.owasu.org/gallery_pics/france02.jpg, under the cave art category brings up an interesting registered cover from France franked with cave painting stamps and a Europa key stamp. A fascinating Kenyan first day cover is signed by Richard Leakey, www.owasu.org/gallery_pics/leakey02.jpg, paleoanthropologist son of Mary and Louis Leakey.

If your grandchildren are interested in ancient civilizations or like the Disney movie Hercules, you might get them hooked on stamp collecting using the Hercules checklist in the freebies section. The free checklist can be downloaded as text or in pdf format. It is a comprehensive list of Herculean stamps from more than 20 countries. A similar list is provided for Nubian Monuments on stamps.

The library section contains an informative and comprehensive bibliographical list of information related to old world subjects, including catalogues, e-books, articles in related philatelic magazines, atlases, books, and the OWASU journal, The Old World Archaeologist. (See previous page for a review.) Live links are available for publications that can be purchased readily online.

The site has a great deal of helpful information for the average collector. Sadly, the group’s efforts to reach out to others through the site will likely disappear without a Webmaster to keep it updated.

— Heather Sweeting

A Virtual Meeting Place

The Peru Philatelic Study Circle was formed in 2006 as a virtual meeting place for those interested in that country’s stamps and postal history. The www.peru-philatelic-study-circle.com site explores different facets of Peruvian philately.

Many specialized societies have turned to the Internet. Some use it as a supplement to society offerings, such as images and information not otherwise offered through printed material. Communication is the key to Internet use as societies employ it as an instantaneous link between the society and current and future members. Is a virtual club cursing its very existence by gambling on the internet as its primary medium, shutting out those collectors without access to a computer?

An elaborate listing of all postmarks from different states spans the period from the 1800s through the 1950s with clear illustrations and detailed annotations for each marking. This project is being updated continuously as new discoveries are added and current information updated, an almost impossible task if the project was published on paper. Other virtual projects include a study of security seals for certified mail in 1916 by Henry Marquez and a philatelic presentation of the war in the Pacific by Richard Abrams. Both projects are highly specialized and the information intricately detailed and spread out given the expanse of the web site.

A virtual expo allows instant access to excerpts from gold medal exhibits that are otherwise inaccessible to collectors to view in person. Links to Peruvian philatelic, non-philatelic and ephemera are numerous and useful.

A useful tool for the specialist, this site can use improvement for the general collector. Nowhere is there information for the beginner or any type of general survey of Peruvian stamps or postal history.

— Alfed Carroccia
An Easy Crossword Creator

Crossword Forge 5.5.1 by Cortis Clark, www.solrobots.com. Mac OS X 10.1 and higher or Windows 98 and higher. ©2008 Sol Robots LLC. Download $49.95 ($48.95 PayPal); CD $15 extra.

I have found that crossword puzzles are a popular feature with most readers and provide a welcome break from more traditional philatelic entertainment, such as quizzes. The main drawback was that they usually are quite difficult to construct. Enter Crossword Forge, which makes the task nearly painless, Type in clues and answers, run the built-in spell check, and hit the make puzzle button.

The program, which was created as an educational learning tool, has some notable differences from traditional crossword design — adjacent blocks of answers cannot be created and the puzzle creator cannot override the program’s automatic generator to add words manually, a small price to pay for its ease of use.

One of the more interesting features is the choice of backdrops: none, traditional solid, or an image. How many programs support English, French, Spanish, German, Italian, Russian, Swedish, Portuguese, Dutch, Greek, Scottish-Gaelic, Afrikaans, Japanese (Hiragana), Japanese (Katakana), Chinese (Simplified), Chinese (Traditional), Punjabi, and Esperanto? It also creates word finds.

As the number of clues increases, so does the time it takes to generate the puzzle. The example here took nearly eight minutes, conveniently allowing time for the editor to take a break.

The biggest problem is the limited number of formats in which a puzzle can be saved — as an image, as text, as a pdf, or as an interactive online puzzle. The built-in image and pdf generators are limited to 72 dpi, too small for print reproduction. The print dialogue, however, offers a better PDF generator. I save the pdf file as an eps file that can be resized and saved in Adobe Illustrator.

I would expect that this issue will be resolved at some point, as there have been more than 162 version revisions to date. I acquired the program in 2004 and am still getting free updates!

— Albert W. Starkweather

Puzzle

Across
1. Farley’s follies feature
2. Specialized collection
3. Diving sea bird
4. Acronym for newly issue stamps
5. Respond
7. Hidden I.D.
9. Like Canadian stamps
12. Wish you were here item
13. Handy small block
14. A change in valuation
15. Characteristic of some Third World stamps
16. Plane on first U.S. airmails
20. Two of a kind
21. Stamp divider
22. Acronym for copies
24. Homebody mail
28. Stamp assassin
29. Joined, but not equal
32. Retouched plate
34. Desirable stamp trait
36. Tee off
39. Two-color printing error
40. Mail staying close to home
41. Famous tentmaker
42. Revenue stamp separator
45. On the nose
48. Stamp repository
49. Conservative Limbaugh
50. Prayer ender
52. Theft deterrent
54. Israeli stamp feature
55. Shakespearean king
58. Never mounted
59. Three for one?
60. Overseas airmail designation
61. Zone successor
62. Central image
63. Plaster companion

Down
1. Stamp handler
6. Roswell sight
8. USPS predecessor
10. A sign of use
11. On a roll
13. Wedding companion
15. Intact envelope
17. Friar’s Club event
18. Postal clerk time saver?
19. Offensive smile
23. Drain
25. Receptacle for ashes
26. This needs scissors
27. Type of therapy
30. Early diesel switch locomotive
31. Like a waffle?
33. Not definitive
34. First day cover feature
35. Coated with phosphor
36. Everyday postage
37. Bene predecessor
38. Longest running British stamps
41. Stamp modifier
43. Hinge alternative
44. Not eye to eye
46. Not mint
47. Hairy ox
48. Speedy delivery method
51. Printers’ signature
53. Estimate weight
54. Israeli stamp feature
55. Shakespearean king
56. Fresh stamp
57. Result of peeling?

Material for reviews may be sent to the editor. Reviews are also welcomed from others. Reviews should be concise and stress those aspects that are helpful examples (positive or negative) for other authors, editors, and publishers. Review requests from those having an interest in the item, such as publishers and distributors, must include a copy of the publication.

— Albert W. Starkweather

Puzzle by Albert W. Starkweather
StampShow 2008 Literature Palmares

StampShow 2008 literature award winners have been named. Judges at the August 14–17 event in Hartford, CT, were John M. Hotchner, chair; John Kevin Doyle; and Roger P. Quinby.

Grand Award
U.S. Contract Mail by Water (Star Routes 1824–1875), Collectors Club of Chicago, publisher; Hugh V. Feldman, author

Reserve Grand
Letter Mail From and To the Old Italian States 1850–1870, Vaccari Srl; Mario Mentaschi and Thomas Mathá, authors


Articles and Columns
Gold
Postal History of Trinidad 1792–1898, American Philatelic Congress; Reuben A. Ramkissoon, author

Vermeil
The Apollo 11 10¢ Air Mail Issue: Analytical Study of the Stamp, Cachets and Cancellations, Parts I, II, and III, AFDCS; Reuben A. Ramkissoon, author
Collection of Articles Published in the EFO Collector, July 2005–December 2007, EFO Collector; Joseph Monteiro, author
Philatelic Bookshelf, Canadian Stamp News, Michael O. Nowlan, author

Silver
Spécial Vélos sur Timbres, www.philateliequebec.com; Guy Derosiers, author

Catalogues
Gold
Classic Romania, David Feldman Auctions publisher
Unificato Di Storia Postale, C.I.F.–Srl, editor
Vaccari Catalogue 2008–2009 — Postage Stamps and Postal History: Historical Study and Catalogue with Valuations, Vaccari Srl; Paolo Vaccari, editor

Vermeil
Christmas Seal Buttons, Pins and Medals of the U.S. (CD), John B. Denune; Louis Caprario, author
Green’s Catalog of Canadian Local & Provincial TB Seals, John B. Denune; Cliff Beattie, editor
Green’s Catalog, Part 1, U.S. National Christmas Seals, John B. Denune; Dick Green, editor
Levy’s Boy and Girl Scout Cachet Covers of the United States, SOSSI; Jay L. Rogers, editor

Handbooks and Special Studies
Gold
Carpatho Ukraine — Postal History and Stamps 1786–2000, Dutch Society for Czechoslovak Philately, Jan Verleg, author
The Congress Book 2007, APC; Kenneth Trettin, editor
Intercepted in Bermuda, Peter A. Flynn, author
The Liberty Series, American Philatelic Society; Ken Lawrence, C. David Eeles, and Anthony S. Wawrukiewicz, authors
Stamps On Music — The World-Wide Catalogue & Handbook of Stamps Issued Under Copyright Acts, Adam Miller, editor
U.S. Contract Mail by Water (Star Routes 1824–1875), Collectors Club of Chicago; Hugh V. Feldman, author
Camp Center: Colorado Ghost Town Mail, Rocky Mountain Philatelic Library; John Willard and Sergio Lugo, authors
Canadian Postage Stamp Errors of the Queen Elizabeth II Era — Vol. I to Vol. III, Joseph Monteiro, editor
Letter Mail From and To the Old Italian States 1850–1870, Vaccari Srl; Mario Mentaschi and Thomas Mathá, authors
Revenue Stamped Paper of Mexico 1821–1876, Donald O. Scott and Frank A. Sternad, authors
United States Patriotic Envelopes of World War II, James E. Lee Publishing; Lawrence Sherman, author

Vermeil
The 2007 Pricing Guide for Unlisted Carriers, Locals, Fakes, Forgeries and Bogus Posts of The United States, Larry Lyons, editor
America on the Map, CartoPhilatelic Society; Miklos Pinther, editor
Bellefonte and the Early Air Mail 1918–1927, American Philatelic Society, Kathleen Wunderly, author
El Quetzal Volumes 1–56 (DVD), International Society of Guatemala Collectors’ Eric Dyck, editor
Society Awards for Best Articles

By Alan Warren

Several philatelic societies offer awards for the best article published during the preceding calendar year in their journal. These encourage writers to submit badly needed articles.

The Military Postal History Society has presented its best article award to Don Kochi for “One Lucky USS Juneau Sailor” in the fall 2007 MPHS Bulletin. He tells of a sailor thought to have died when the Juneau was torpedoed on November 13, 1942. It sank quickly, having only 10 survivors. Mail addressed to John M. Thompson was returned without explanation. It turned out that he had been transferred to the USS Lackawanna just before the sinking.

Alfred Kugel won the Germany Philatelic Society’s George Blizil Memorial Literature Award for his 2007 article about the German airship base at Jamboli, Bulgaria in the June 2007 German Postal Specialist. He describes the base at Jamboli, Bulgaria and discusses the zeppelin L 59 that was loaded with supplies for the troops in German East Africa. During the flight it received a false message that caused it to return to Jamboli.

The American First Day Cover Society’s annual Philip H. Ward, Jr. Memorial Award, named for the Philadelphia collector, dealer, journalist, and pioneer in servicing FDCs, is for the best article showing outstanding first day cover writing and research. Although articles from other journals may be entered, those appearing in the AFDCS magazine, First Days, during the preceding calendar year are automatically considered. The winner is Robert Lewin for “The Magnificent Covers of Ejgil J. S. Halvorsen” in the December 2007 First Days. He uncovered new information and previously unrecorded covers by Halvorsen, who possibly created the earliest hand-painted cachets beginning in the early 1920s. Runner-up was Ralph Nafziger for his September article, “The Harris–Hoffman Connection.” He describes how Marvin Harris and Michael Hoffmann began producing their own cachets and then worked together in the late 1950s and 1960s to issue the Diamond and Lone Star cachets.

The Universal Ship Cancellation Society presents two annual Heneyman awards for articles in its journal, USCS Log. One is for the best article that deals with naval or maritime history. The other is for the best article on naval/maritime postal history or philately. The awards are named for Stanton Heneyman, a longtime member and a past president of the society and editor of the journal.

The Scandinavian Collectors Club presents its Frederick A. Brofos award for the best article in its journal, The Posthorn. The award is named after a former editor of the magazine.

The United States Stamp Society offers its Walter W. Hopkinson Memorial Award for the best article reflecting scholarship and research to appear in its journal The United States Specialist. The society also sponsors the annual Barbara R. Mueller award for the best article appearing in the American Philatelic Society’s American Philatelist. The first winners are co-authors Steven J. Berlin and James W. Milgram for “Early Mail Robberies in the United States,” which appeared in the November 2007 AP.

Suggestions for Literature Competition Entrants

By John M. Hotchner

Experience is the best teacher. Having worked on two literature juries this year, the experience has taught me that every producer of philatelic literature — be it a book, society journal, catalogue, monograph, or club newsletter — needs to include a clear goal statement. It can be informal — a few sentences in the author’s or editor’s preface of a book or catalogue or a formal statement arrived at by consensus among club officers.

It is important to have such a statement for literature juries who need to know the benchmark the author or editor is working toward. It is even more important for authors and editors to have thought out what they are attempting to do. For instance, a journal that is understood to be one of record reflecting the history of a society suggests content should include activities, photographs with people clearly identified, and brief reports on what happened at meetings immediately preceding each issue.

If a major reason for producing a catalogue is to provide reliable pricing information in a single resource, the editor must take special care to explain how prices were determined. Generally it should not refer readers to other volumes for essential information about material closely allied to that in the present volume.

Society publications often need to be clear about what they are covering in time and geography. Does the Netherlands society include current and past Dutch colonies in its purview? Does the Italian society include the period prior to confederation?

In summary, knowing what you are aiming for is the first step in getting there.

The second lesson from my judging experiences is that literature entrants would help themselves and help juries by providing a synopsis — very much like those prepared for stamp/cover exhibits.

What To Include

Included should be:

• The goal statement and how well you think you have done in meeting it.
• Any special difficulties overcome in the past couple of years — changes in editorial staff, moving to color, changes in length or frequency, etc.
• Defending practices that judges in the past have questioned, where you think the criticisms were not warranted.
• The track record in prior shows.
• The size of your sponsoring organization, which has a bearing on financial resources available for production.
• For books and monographs, include how long has the project been in progress and the availability of source material needed in their preparation.

This is not meant to be an exhaustive list, but just some of the information the judges may want to know. There is no present requirement that you provide such a document. This is simply a suggestion.
New Members
1958 Scott A. Shaulis, 3955 Hickory Hill Road, Murrysville, PA 15668-9543. Editor: Permit Patter (Mailer’s Postmark Permit Club); Columnist: “Becoming A Stamp Dealer” (American Stamp Dealer & Collector). Sponsor: Peter Mosiondz.

Change of Address
1662 Alvin R. Kantor, 2430 76th Avenue, S.E., Mercer Island, WA 98040-3351.
1838 James Bryan Berryhill, Jr., 104 Palomino Crossing, Woodway, TX 76712-8885.

Contributions
We thank the following for a generous contribution over and above the payment of their 2009 membership dues.
0113 Charles J. Peterson, Laurel, Maryland ($7.00)

WU #30 Board Meeting
The Writers Unit #30 Board will have its bi-annual meeting at 10 a.m. on February 22 during APS AmeriStamp Expo / TEXPEX. The meeting will follow the WU #30 breakfast at the Sheraton Arlington Hotel in Arlington, TX. See breakfast advertisement on page 3.

About Writers Unit #30
The purpose of the Writers Unit #30 of the American Philatelic Society is to encourage and assist philatelic communication, knowledge, and comradeship. Membership is open to any philatelic writer, columnist, editor, or publisher, as well as anyone interested in philatelic communication.

Join Us Today
Join Writers Unit #30 today and begin reaping the many benefits of membership, including your subscription to The Philatelic Communicator.

Applications received before October 1 will be recorded as members for that calendar year and these members will receive all four issues of The Philatelic Communicator for the calendar year.

Applications received on or after October 1 will be recorded as members for the following calendar year.

An application may be downloaded at www.wu30.org.

Membership Dues
USPS ZIP Code Addresses........................................... $15.00
Canada and Mexico ..................................................... $17.50
All Other Addresses..................................................... $20.00

Payment must be made in U.S. funds by a check imprinted with a U.S. bank transit number, or by postal money order, payable to APS Writers Unit #30. Some overseas members prefer to send U.S. bank notes by certified mail.

Updating Your Mailing Address
Please notify us of address changes to assure that you receive each issue of The Philatelic Communicator without delay. This will also save WU #30 more than $1.00 because the USPS charges 50 cents when they have to send us an address correction, and we still have to pay the postage for reshipping the issue to the member.

George B. Griffenhagen
WU #30 Secretary-Treasurer
2501 Drexel St.
Vienna, VA 22180-6906
ggriffenhagen@akphanet.org

Philatelic Communicator Advertising Rate Card
We can accept camera-ready copy or create an ad for you.

Full Page — $80 • 7.33 x 10 inches; 44 x 60 picas
Half Page — $55 • Vertical 3.6 x 9.5 inches; 21p6 x 57 picas;
Horizontal 7.33 x 4.7 inches, 44 x 28p6 picas
Quarter Page — $35 • 3.6 x 4.6 inches, 21p6 x 28p6 picas

Deadlines January 15, April 15, July 15, October 15
Contact the editor at 813-962-7964; e-mail astarkweather@wu30.org
Articles

Francis Adams: Template for Digital References and Studies ..... 1
Grammar Horror Alert! .............................................................. 4
Brian J. Birch: Handbooks and Style Guides for Philatelic Authors and Editors: A Bibliography ........................................... 8
StampShow 2008 Literature Palmares ........................................ 16

John Hotchner: Literature Competition Entrants Suggestions ..... 18
Alan Warren: Society Awards for Best Articles ......................... 18

Departments

Editor's Domain: The Communicator Going Color in January ..... 2
President's Message: Breakfast and Board Meeting Reports ...... 3
Short Takes: News & Commentary ........................................... 4
Expert Help for Writers and Editors ....................................... 4
Reviews

Books & Catalogues
CD Adds Value To Catalogue..................................................... 10
Australian Air Catalogue Updated ........................................ 10
Handbook Expands on Catalogues .......................................... 11
Translation Opens Study Area ................................................. 11
New Michel Catalogues ......................................................... 12

Journals & Newsletters
Putting on a New Face ............................................................. 13
Briefly Noted
The Precancel Forum ............................................................. 13
The Old World Archaeologist ................................................. 13
The Czechoslovak Specialist .................................................. 13

Electronic Media & Software
Exploring Archaeology Online ............................................... 14
A Virtual Meeting Place .......................................................... 14
An Easy Crossword Creator ..................................................... 15

Advertisements

Writers Unit #30 Breakfast .......................................................... 3
StampExpo 400 ......................................................................... 9

Secretary–Treasurer’s Report .................................................... 19